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Introduction

1.1 Functional Description

The TVP7002EVM is composed of the TVP7002 board and the THS8200 board when they are connected
together. Both boards share a common interface via a 120-pin connector. This interface provides all data,
clocks, 1°C communication, and 5-V power to each board.

The THS8200 is a Texas Instruments triple digital-to-analog converter (DAC) providing component analog
RGB or YPbPr outputs. The THS8200 supports resolutions up to UXGA for PC graphics and up to 1080p
for video. This triple DAC minimizes artifacts commonly associated with backend processing. Its purpose
is only to convert the digital data from the TVP7002 triple analog-to-digital converter (ADC) back to
analog. Use of a TV or display capable of supporting both component RGB and YPbPr analog inputs is
recommended.

1.2 Overview

The TVP7002EVM is powered by a single 5-V universal supply. I?°C communication is emulated using a
PC parallel port configured for the extended capability port (ECP) or bidirectional mode. The parallel port
mode can be changed using the PC BIOS setup, available during the reboot process.

The TVP7002 triple ADC converts three channels of analog video input into digital component data. This
digital data and the associated clocks from the TVP7002 are sent to the THS8200.

Control of the TVP7002EVM is provided by WinVCC4, a Windows™-based application developed by
Texas Instruments and provided free of charge. This application uses the parallel port to provide 1°C
communication to the TVP7002EVM. WinVCC4 provides a graphics user interface (GUI) and a register
level interface to program and vary the controls available within the TVP7002 triple ADC and the
THS8200.

Macrovision is a trademark of Macrovision Corporation.
Windows is a trademark of Microsoft Corporation.
All other trademarks are the property of their respective owners.

SLEU098—-May 2008 Introduction 7
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1.3 Board-Level Description
The following sections describe the various features available on the TVP7002EVM. shows the
TVP7002EVM block diagram.
5V
DB15 II-EI)
Reset |:||20 D LED
ﬁDR [ ] Test Points
. - R/Pr
[} []
EXT PWDN 3 3 |:|
VSYNC CLK 2 €
£ £ THS8200
(&) o
TVP7002 5 5
HSYNC g o 5
£ ks ks GIY
o £ £
1 I O -
Gy k8 & DB15
R/Pr
B/Pb [ |

1.3.1 Analog Inputs

Figure 1-1. TVP7002EVM Block Diagram

The TVP7002EVM uses all the available inputs on the TVP7002 triple ADC. The following inputs are

available for use:

* Five BNC connectors (Y/G, Pb/B, Pr/R, HSYNC, and VSYNC)
» One DB15 graphics connector (Y/G, Pb/B, Pr/R, HSYNC, and VSYNC)

shows the pins used for the inputs described above.

Table 1-1. Analog Inputs and Pin Terminals

Input Type TVP7002 Pins
5-BNC RIN_1, GIN_1, BIN_1, VSYNC_B, HSYNC_B
DB15 RIN_3, GIN_3, BIN_3, VSYNC_A, HSYNC_A

Note: Both the TVP7002 and THS8200 EVMs include PCB footprints for passive (LC) anti-alias
and reconstruction filters. Due to the wide variety of formats that are supported, both boards
are shipped from the factory with these filters bypassed and unpopulated.

1.3.2 External Reference Clock and External Clock Input

The EVM is shipped with a 27-MHz crystal oscillator that can be used as a stable reference clock
(REFCLK) for input format detection. The REFCLK output is connected to pin 80 of the TVP7002 and is
used by the TVP7002 to report line length and HSYNC width status for input detection (see

for more detail).

8 Introduction

SLEU098—-May 2008
Eubmit Documentafion FeedbacH



http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLEU098

13 TEXAS

INSTRUMENTS

www.ti.com Board-Level Description

1.3.3

134

135

An SMA connector (EXTCLK) for use with an external ADC sample clock is also provided. This input is
end-terminated with a 50-Q resistor for use with a lab clock generator and can be routed to pin 80
(EXTCLK) of the TVP7002 with a slight jumper configuration change. An external ADC sample clock can
be used by setting the PCLK SEL bit in I°C register 1Ah to 0. Removal of the termination resistor may be
required for some clock sources incapable of driving the 50-Q load.

Note: The EVM is shipped from the factory with the 27-MHz oscillator connected to pin 80 of the
TVP7002. To use the EXTCLK, the 0-Q resistor installed at J3 can be moved from the OSC
position to the EXT position.

Test Points and Jumpers

Various test points are available on the TVP7002EVM. This includes DCLK (DATACLK), HS (HSOUT), VS
(VSOUT), DE_FID, SOG_OUT, SDA, SCL, power, and GND. Each test point is clearly labeled on the
TVP7002EVM silkscreen. The primary test-point headers for the TVP7002 are H2, H3, and H4, which
provide access to the red, green, and blue data, respectively.

There are two jumpers on the TVP7002 board that configure the power-down mode and 1°C address
select. Each jumper is set by default in its preferred state for the TVP7002EVM. Near each jumper on the
TVP7002 board is a silkscreen that describes the two states of the jumper configuration.

Table 1-2. I°C Address Selection Jumper (I12C ADDR)

I2C ADDR Jumper I°C Address
1-2 0xB8
2-3 OXBA

Table 1-3. Power Down Mode Selection Jumper

(PWDN)
PWDN Jumper Operation
1-2 Normal operation
2-3 Power down

Note: If the I°’C address is changed on either the TVP7002 board or the THS8200 board while the
TVP7002EVM is powered up, then that device does not recognize the new I°C address. The
reset button on the TVP7002EVM must be pressed, and WinVCC4 must be reconfigured for
the new I>C address.

Common Board Interface

The TVP7002EVM uses a 120-pin connector to connect the TVP7002 board (P3) to the THS8200 board
(P2). This interface shares all common signals including the I2C and the 5-V supply. This modularizes the
TVP7002 board and allows users to interface it to a variety of other Texas Instruments products including
DVI transmitters, video encoders, or to any other platform that shares the same interface.

This connector shares all digital video data (R[9:0], G[9:0], and B[9:0]), all video clocks (DCLK_OUT,
VSYNC, and HSYNC), RESET, I°C, and 5 V as mentioned above.

Component Analog Outputs

The THS8200 board provides component analog outputs to a display RGB or YPbPr formats. The
configuration settings for the TVP7002EVM use the RGB color space for PC graphics and the YPbPr color
space for video (480i to 1080p).

SLEU098—-May 2008 Introduction 9
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1.4 System Level Description
The system block diagram in gives an example of how the TVP7002EVM may be used for
evaluation. Typically, an RGB or YPbPr component analog input is provided by a graphics/video source
such as a pattern generator or a DVD player.
The TVP7002EVM is configured with the provided 5-V supply and the parallel port cable. The output is
provided by the THS8200 triple DAC to convert the digital data from the TVP7002 back to analog. This
analog output is then fed into a display monitor.
PC
(re Sapp!
Control) PRl
Y/G
Pb/B
Quantum .
Video/Graphic | Pr/R TVP7002EVM bvi “':,'I'SP'aV
onitor
Source HS
VS
Figure 1-2. TVP7002EVM System Level Block Diagram
10 Introduction SLEU098-May 2008
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Hardware and Software Setup

2.1 Required Hardware and Equipment

The required hardware and equipment necessary to use the TVP7002EVM are:

TVP7002EVM (provided)

Universal 5-V power supply (provided)

Parallel cable (provided)

Windows-based PC

One cable with five BNC connectors (RGB, HS, VS)

One cable with three BNC connectors (RGB or YPbPr)

Two DB15 PC cables

Video source (multiformat video/graphics signal generator or DVD player)
Display monitor that supports PC graphics and video up to 1080p

2.2 Hardware Setup

Perform the following steps to set up the hardware for the TVP7002EVM:

1. Connect the TVP7002 board and the THS8200 board using the 120-pin board connector. The two
boards connected together are called the TVP7002EVM.

2. Connect a video or graphics source to the DB15 input connector or the RGB, HSYNC, and VSYNC
input connectors of the TVP7002 EVM. The HSYNC and VSYNC input connections are not required if
component video sources with sync-on-y are used.

3. Depending on the desired output format, connect either a graphics DB15 cable or video BNC cable to
the output of the THS8200 board.

4. Connect the parallel port cable from the TVP7002EVM to the PC.

Note: There are footprints for a dc jack on the THS8200 board, but the default power is provided
by the TVP7002 board via the 120-pin connector, P3.

5. Connect the 5-V power supply to the dc jack on the TVP7002 board. A green LED on each board
should light.

SLEU098—-May 2008 Hardware and Software Setup 11
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2.3 Software Installation
WinVCC4 is a Windows application that uses the PC parallel port to emulate 1C, providing access to each
device on the I1°C bus. WinVCC4 makes use of CMD files, a text editable file that allows preset video
setups to be programmed easily.
This feature allows the user to easily set multiple I°C registers with the press of a button. WinVCC4 also
has property sheets for the TVP7002, which allows the user to control the I°C registers with a graphical
user interface (GUI).
All necessary software for the TVP7002EVM is provided on the enclosed CD. Perform the following steps
to install WinVCC4:
1. Explore the provided TVP7002EVM software CD.
2. Run Port95NT.exe to install the parallel port driver used by WinVCC4.
This driver must be installed, and the PC must be rebooted before WinVCC4 can operate correctly.
3. Run Setup.exe to install WinVCC4.
Click Next at all prompts and click Finish to complete the installation process. No reboot is required.
4. Run WinVCC4.exe
Note: A shortcut to WinVCC4 should now be available on the desktop. Another shortcut to
WinVCC4 and additional TVP7002 related documentation can be found at
Start>Programs>TVP7002EVM Software.
12 Hardware and Software Setup SLEU098-May 2008
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WinVCC4 Quick Start

Perform the following steps to enable video output from the TVP7002EVM.

1. Run WinVCC4. When the WinVCC4 Configuration screen appears, use it to configure the 1°C bus.

2. Next to TVP7002, select the TVP7002 and ensure the I°C address is set to OxB8. The address
selected here must match the address selected by the 12C ADDR jumper on the TVP7002 board.

3. Next to THS8200, select the THS8200 and ensure the I°C address is set to 0x40. The address
selected here must match the address selected by the 12C ADDR jumper on the THS8200 board.

Note: If WinVCC4 is running and the TVP7002 or THS8200 board I?C address is changed, then
power must be cycled on the EVM to enable the EVM to use the new address.

WinVCC Configuration

13 TEXAS
INSTRUMENTS
12C SYSTEM CONFIGURATION
DEVICE FAMILY SPECIFIC DEVICE 12C BUS MASTER 12C SLAVE ADDR
Slave Address
TVPI300 NOT USED v * B8h (" BAh
(ATSC/QAM Demodulator) I _I I _]
VID_DEC [NOT USED ~| | ~| | @ Bsh ¢ Ba&h
[Analog Video Decoder)
VID_ENC NOT USED - * 40h O 42h
[Analog Video Encoder) | —] I _]

TVP7000 TVP7002 - @ BSh " BAh

[Video/Graphics Digitizer)

THS8200 .
(HDTV/SDTV/RGB DAC) | THS8200 =l | ] | & 4on © azn

PROGRAM OPTIONS

ENABLE | 12C System Test (after clicking OK)
ENABLE | I12C Acknowledge Checking

ENABLE Auto-Update from Device (when activating a
window or tabbing between property pages)
0K | Exit Program

Figure 3-1. WinVCC4 — I2C Configuration Screen

4. Ensure that all other boxes are selected as "Not Used" and that all program options buttons are set to
ENABLE. Click OK.

5. If there are no 1°C communication problems, then the Main Screen window displays next. If there are
I2C problems, then an I>’C Test Report box displays. Completely exit out of WinVCC4, double-check
the parallel port cable connections, cycle power on the TVP7002EVM, and run WinVCC4 again.

SLEU098-May 2008 WinVCC4 Quick Start 13
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6. Load the provided TVP7002EVM.CMD  file into  WinvVCC4 by  clicking on
Tools>System Initialization>Browse. The default directory is c:\Program Files\Texas

Instruments\TVP7002EVM\Initialization.

*> Windows Video Control Center (WinVCC v5.24 )

File Edit Tools Window Help
— —

Figure 3-2. WinVCC4 — Main Screen

7. Click the desired "TVP7002 + THS8200_..." dataset in the window, and then click the Program Dataset
button to initialize the TVP7002EVM.

System Initialization

Command File C:\Program Files\Texas Instruments\TYP7002EVM\Initialization\TVP7002EVYM.CMD Browse...
Command File Operations Bytes Per Block
(0= Allin 1 block) Reload
REPLACE APPEND PROGRAM
Selected Dataset Current Device(s) 0
with Current Device Settings Using
Device Settings to CMD File Selected Dataset Status
| Ready Close

Dataset Descriptions

7 = TVP7002+THS8200_480i 15.734khz - 13.5 MHz PLL

8 = TVP7002+THSB8200_480i 15.734khz - 27 MHz 2x PLL
9 = TVP7002+THSB8200_480p - 31.468Khz - 27 Mz 1x PLL
10 = TVP7002+THS8200_480p - 31.468Khz - 54 Mz 2x PLL
11 = TVP7002+THS8200_576i 15.625khz - 13.5 MHz

12 = TVP7002+THS8200_576p 31.25khz - 27 MHz

13 = TVP7002+THS8200  720p -60Hz- 45khz - 74.25Mhz

14 = TVP7002+THS8200_ 720p -50Hz- 37.5khz - 74.25Mhz
15 = TVP7002+THS8200_1080i - 60Hz - 33.75 Khz - 74.25Mhz
16 = TVP7002+THS8200_1080i-50Hz - 28.125 Khz - 74.25Mhz
17 = TVP7002+THS8200_1080p-60Hz 67.5KHz - 148.5MHz
18 = TVP7002+THS8200_1080p-50Hz 56.25 KHz - 148.5MHz

19=
20 = === TVP7000 + THS8200 VESA Formats- VGA Input =+
21 = TWP7NN2+THGR2NN RANvARNVANH .31 Rkh> - 28 17AMH> INMTRRM HEA/S ./ ™

NOTES:
1. To access the factory-supplied initialization files, browse to: c:\Program Files\T exas Instruments\WinYCC4\TVP7000\I nitialization'\*.cmd

2. If REPLACE or APPEND functions will be used, click RELOAD whenever the video decoder EVM is reset or power-cycled.

Figure 3-3. WinVCC4 — System Initialization

8. With a graphics/video source provided at the BNC or DB15 connectors and with the proper resolution
configured, video or graphics should be viewable on the display monitor.

To ensure that the TVP7002 is working properly, go to Status and check the HSYNC and
VSYNC detection status. If using the YPbPr inputs with sync-on-y, then the SOG status
should indicate "DETECTED", and the HSYNC and VSYNC input status should indicate

"FROM SOG" and "FROM SYNC SEP", respectively.

Note:
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WinVCC4 in Depth

This chapter describes in depth how to use WinVCC4. The various features and screens that the user
may encounter while evaluating the TVP7002EVM are described.

4.1 Starting WinVCC4

The Port95NT parallel port driver must be installed before using WinVCC4. WinVCC4 may be started by
clicking on Start>All Programs>TVP7002EVM Software>WinVCC4.

If the dialog box shown in is displayed, one of two things is indicated:

1. WinVCC4 did not run to completion the last time it ran. In this case, click OK to exit the program and
restart WinVCC4.

2. There is more than one instance of WinVCC4 running at the same time. In this case:
Click OK to exit the program.
Press CTRL-ALT-DELETE to open the Task Manager.

Select and click End Task for all occurrences of WinVCC4 or WinVCC4 CONFIGURATION.
Restart WinVCC4.

cpow

' If the previous run of Win¥CC4 was terminated abnormally, click OK and start Win¥CC4 again. Otherwise, more than
one instance of Win¥CC4 may be running! Click OK to close this program. Then, press Ctl-alt-Delete. Highlight and
click "End Task" to terminate all instances of Windows Video Control Center {or WINVCC4 Configuration).

Figure 4-1. WinVCC4 Multiple Occurrences Error Message

4.2 WinVCC4 Configuration Dialog Box

The WinVCC4 Configuration dialog box (see Figure 4-2) should now be visible. This dialog box configures
the I1°C bus on the TVP7002EVM. All settings from this dialog box are stored in the Windows registry and
are restored the next time the program is started. After initial installation, TVP7000 Video and Graphics
Digitizer drop down box is set to TVP7002.

The I1°C slave address for each device must match the 1°C slave address selected by jumpers on the
TVP7002EVM. These jumpers are set by the factory to use 0xB8 for the TVP7002 and 0x40 for the
THS8200 transmitter.

It is also important to ensure that only the TVP7002 is selected when using the TVP7002EVM. All
Progzram Options must be enabled. Disabling these options is required only if debugging a problem with
the 1°C bus.

Click OK to begin 1°C communication with the selected devices.

SLEU098-May 2008 WinVCC4 in Depth 15
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WinVCC Configuration

PROGRAM OPTIONS

4

ENABLE | 12C Acknowledge Checking

ENABLE | 12C System Test (after clicking OK)

OK

ENABLE | Auto-Update from Device (when activating a
window or tabbing between property pages)

Exit Program

1,
INSTRUMENTS
12C SYSTEM CONFIGURATION
DEVICE FAMILY SPECIFIC DEVICE 12C BUS MASTER 12C SLAVE ADDR
Slave Address
TVP3300 NOT USED v v + B8h  Bah
[ATSC/QAM Demodulator) I _] I _]
VID_DEC [NOT USED || ~| | @ Beh  BAh
[Analog Video Decoder)
VID_ENC NOT USED v v * 40h  42h
[Analog Video Encoder) I :I I _I
TVP7000 R | | =] 8 C ean
Video/Graphics Digitizer)
THS8200
(HDTV/SDTV/RGB DAC) | THS8200 =] =) | ® 40n © 42

Figure 4-2. WinVCC4 I°C Address Configuration
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4.3 I°C System Test

The 1°C system test of selected registers runs immediately after closing the WinVCC4 Configuration dialog
box by clicking OK (unless the 1°C system test program options button was disabled).

If the 1°C system test passes, then only a PASS message appears. If the test failed, then a dialog box
appears (see Figure 4-3). See for details on how to resolve this issue.

The 1°C system test can be run at anytime by clicking Run System I1°C Test in the Tools menu.
12C Test Report

THS8200...FAILED - Read, Dev=0x40, Addr=0x05, D ata=0x00 - Miscompare [Wraote 0x01)

TVP7002...FAILED - Read, Dev=0sBA, Addr=0x04, D ata=0=00 - Miscompare [Wrote 0x03)

Figure 4-3. I°C System Failure
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4.4

Main Menu

After configuring the I12C, the main menu is displayed as shown in Figure 4-4. The menus that are used to
operate WinVCC4 are File, Edit, Tools, Window, and Help. The File menu's only function is Exit, which
terminates the program. summarizes the main menu contents.

*> Windows Video Control Center (WinVCC v5.24 )

File Edit Tools Window Help

Figure 4-4. WinVCC4 — Main Screen

Table 4-1. Main Menu Summary

Menu Contents

File Exit
Edit Register Map

TVP7002PNP

Generic I1°C Editor
Property Sheets

TVP7002PNP
Tools System Initialization

Real-time Polling

TV Tuner Control (FQ12xx series only)
Multiple-Byte I°C Transfers

Set IC Bit Rate

Run System 1°C Test

Run Continuous I°C Test

Read VBI FIFO

Capture Live VBI Data
Window Allows selection of the active window. Multiple windows can be open at the same time.
Help Displays program version

4.4.1 System Initialization

Click System Initialization in the Tools menu to display the dialog box shown in Eigure 4-3. This dialog box
provides the means for initializing the TVP7002 triple ADC and/or THS8200 for a particular video mode.
The details of the initialization are contained in the command file (with a CMD file extension).

The command file is loaded using the Browse... button. Once the command file is opened, a text list
displays descriptions of the individual datasets contained within the command file.

Click once on the desired dataset description to select it. Click the Program Device(s) Using Selected
Dataset button to run the selected dataset, which loads the devices via the IC bus. When the device
initialization has completed, the status indicator displays Ready.

Note: If Ready does not display, then the devices are not initialized and the 1°C bus is not
communicating. See for possible solutions.

Click the OK button to close the dialog box. Each time the System Initialization dialog box is closed, the
initialization file pathname and the dataset selection number are saved in the Windows registry to allow
these settings to be retained for the next time WinVCC4 runs.

18
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System Initialization

Command File C:\Program Files\T exas Instruments\TYP7002EVM\Initialization\TVP7002EVYM.CMD Browse...

REPLACE APPEND PROGRAM
Selected Dataset Current Device(s) 0
with Current Device Settings Using
Device Settings to CMD File Selected Dataset Status
I Ready Close

Dataset Descriptions

Command File Operations B
ytes Per Block
(0 =Allin 1 block) Reload
A~

7 = TVP7002+THS8200_480i 15.734khz - 13.5 MHz PLL
8 = TVP7002+THS8200_480i 15.734khz - 27 MHz 2x PLL

9 = TVP7002+THS8200_480p - 31.468Khz - 27 Mz 1x PLL

10 = TVP7002+THS8200_480p - 31.468Khz - 54 Mz 2x PLL

11 = TVP7002+THS8200_576i 15.625khz - 13.5 MHz

12 = TVP7002+ THS8200_576p 31.25khz - 27 MHz

14 = TVP7002+THS8200_ 720p -50Hz- 37.5khz - 74.25Mhz
15 = TVP7002+ THS8200_1080i - 60Hz - 33.75 Khz - 74.25Mhz
16 = TVP7002+THS8200_1080i50Hz - 28.125 Khz - 74.25Mhz
17 = TVP7002+THS8200_1080p-60Hz 67.5KHz - 148.5MHz
18 = TVP7002+ THS8200_1080p-50Hz 56.25 KHz - 148.5MHz
19=

21 = TUP7NN2+THSR2NN RANvARNVANH 2.1 Rkh> - 25 178MH> INMTRRM HEAJS ./

NOTES:
1. To access the factory-supplied initialization files, browse to: c:\Program Files\T exas Instruments\WinVCC4\TVP7000\ nitialization\*, cmd

2. If REPLACE or APPEND functions will be used, click RELOAD whenever the video decoder EVM is reset or power-cycled.

20 = o TVP7000 + THS8200 VESA Formats- VGA Input === 3

Figure 4-5. System Initialization

44,11 Adding a Custom Dataset

After programming the EVM via the System Initialization tool using the factory-supplied command file
through the Property Sheets tool, the device register settings can be customized. Perform the following

steps to save the custom settings:

1.
2.

E

Reopen the System Initialization dialog box via the Tools menu.

Click the Append Current Device Settings to Command File button. A dialog box requesting a

description of the new dataset appears.
Optionally, click the dropdown box and select one of the existing descriptions.

Modify the description text or type a description.

Click OK. All nondefault register values from the TVP7002 and THS8200 are appended to the current

command file as an additional dataset.

Select the custom dataset and send it by pressing the Program... button.

Note: The command file (.CMD) must be saved as plain text.

4.4.1.2 Command Files

The command file is a text file that can be generated using any common editor; however, it must be saved
as plain text. Command files are especially useful for quickly switching between the various system
configurations. These .CMD files are unrelated to the typical Windows .CMD files.

A default command file has been provided on the CD. This command file contains most of the desired
setups. This command file is located at:

c:\Program Files\Texas Instruments\TVP7002EVM\Initialization\TVP7002EVM.cmd

SLEU098—
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A command file can contain up to 250 datasets. A dataset is a set of register settings to initialize the
TVP7002 triple ADC and/or THS8200 for a particular video mode. Each dataset includes a description that
is displayed in one row of the dataset descriptions list. The register settings may be located in the
command file itself and/or may be stored in separate include file(s) (with an .INC file extension) and be
included into the command file using the INCLUDE statement.

4.4.1.3 Example Command File

The following is an example of one dataset within a command file.
NN NNy

BEG N_DATASET //
DATASET_NAME, " TVP7002+THS8200_720p- 60Hz- 45khz - 74. 25Mhz"

/1 TVP7002

WR_REG, TVP7000, 0x01, 0x01, 0x67 // PLL DI VMSB 1650

WR_REG, TVP7000, 0x01, 0x02, 0x20 // PLL DI VLSB

WR_REG, TVP7000, 0x01, 0x03, 0xA0 // VC2_CP3_RR CP_R

WR_REG, TVP7000, 0x01, 0x04, 0x80 // PHASE SEL(5) CKDI CKDI DI V2

WR_REG, TVP7000, 0x01, 0x05, 0x32 // CLAMP START

WR_REG, TVP7000, 0x01, 0x06, 0x20 // CLAMP W DTH

WR_REG, TVP7000, 0x01, 0x07, 0x28 // HSYNC OQUTPUT W DTH - 40

WR_REG, TVP7000, 0x01, 0x08, 0x3C // Blue Fine Gain

WR_REG, TVP7000, 0x01, 0x09,0x3C // Green Fine Gain

WR_REG, TVP7000, 0x01, 0x0A, 0x3C // Red Fine Gain

WR_REG TVP7000, 0x01, Ox0B, 0x80 // Blue Fine O fset

WR_REG, TVP7000, 0x01, 0x0C, 0x80 // Green Fine Ofset

WR_REG TVP7000, 0x01, 0x0D, 0x80 // Red Fine O fset

WR_REG, TVP7000, 0x01, OxOE, 0x24 // SYNC CONTRCL HSout + VSout +
WR_REG, TVP7000, 0x01, OxOF, Ox2E // PLL and CLAMP CONTROL

WR_REG, TVP7000, 0x01, 0x10, Ox5D // SOG Thr eshol d- (YPbPr C anp)

WR_REG, TVP7000, 0x01, 0x11, 0x40 // SYNC SEPERATOR THRESHOLD

WR_REG, TVP7000, 0x01, 0x12, 0x01 // PRE_COAST

WR_REG, TVP7000, 0x01, 0x13, 0x00 // POST_COAST

WR_REG, TVP7000, 0x01, 0x15, 0x04 // Qutput Formatter

WR_REG, TVP7000, 0x01, 0x17,0x00 // M SC Control 2 FID out, Enable Qutputs
WR_REG, TVP7000, 0x01, 0x18,0x01 // M SC Control 3 C ock polarity
WR_REG, TVP7000, 0x01, 0x19, 0x00 // | NPUT MJX SELECT CHl sel ected (BNC )
WR_REG, TVP7000, 0x01, Ox1A, 0xC7 // |1 NPUT MJX SELECT2, SOG Cl anp filter, HSYNC B and
VSYNC_B

WR_REG, TVP7000, 0x01, Ox1B, 0x77 // Default Blue and G een coarse anal og gain
WR_REG, TVP7000, 0x01, 0x1C, 0x07 // Default Red coarse anal og gain
WR_REG, TVP7000, 0x01, 0x21, 0x35 // HSQUT START (13+40)

WR_REG, TVP7000, 0x01, 0x22, 0x00 // MACEN=0

WR_REG, TVP7000, 0x01, 0x26, 0x80 // ALC Enabl e

WR_REG, TVP7000, 0x01, 0x28, 0x53 // Default ALC FILTER Contr ol

WR_REG, TVP7000, 0x01, Ox2A, 0x87 // CM O fset, Enable FINE CLAMP CONTROL
WR_REG, TVP7000, 0x01, 0x2B, 0x00 // POANER CONTRCL- SOG ON

WR_REG, TVP7000, 0x01, 0x2C, 0x50 // ADC Set up

WR_REG, TVP7000, 0x01, 0x2D, 0x00 // Coarse d anp COFF

WR_REG, TVP7000, 0x01, Ox2E, 0x80 // SOG d anmp ON

WR_REG, TVP7000, 0x01, 0x31, Ox5A // ALC PLACEMENT

WR_REG, TVP7000, 0x01, 0x34, 0x07 // Macrovi sion Stripper Wdth

WR_REG, TVP7000, 0x01, 0x35, 0x00 // VSout Align

WR_REG, TVP7000, 0x01, 0x36, 0x00 // Sync Bypass

WR_REG, TVP7000, 0x01, 0x3D, 0x06 // Line Length Tol erance

WR_REG TVP7000, 0x01, 0x3F, OxOF //Vi deo B/ W contr ol

WR_REG, TVP7000, 0x01, 0x40,0x39 // AVID Start 313 (300+13)

WR_REG, TVP7000, 0x01, 0x41,0x01 // AVID Start

20
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WR_REG, TVP7000, 0x01, 0x42, 0x39 //
WR_REG TVP7000, 0x01, 0x43, 0x06 //
WR_REG TVP7000, 0x01, 0x44, 0x05 //
WR_REG TVP7000, 0x01, 0x45, 0x05 //
WR_REG, TVP7000, 0x01, 0x46, Ox1E //
WR_REG, TVP7000, 0x01, 0x47, OXx1E //

/1 THS8200 720p- 60Hz

WR_REG, THS8200, 0x01, 0x03, 0x01 //
/1 CSC not used

WR_REG, THS8200, 0x01, 0x19, 0x03 //
WR_REG, THS8200, 0x01, 0x1C, 0x60 //

AVID St op
AVI D St op
VBLK FO O f set

VBLK F1 O f set

VBLK FO Duration 30 lines
VBLK F1 Duration

1593 (313 + 1280)

chip_ctl

csc_offset3 - CSC bypassed
dman_cntl - 30 bit input format

/1 conposite sync anplitude control

WR_REG THS8200, 0x01, 0x1D, 0x00 //
WR_REG, THS8200, 0x01, Ox1E, 0x49 //
WR_REG THS8200, 0x01, Ox1F, OxB6 //
WR_REG THS8200, 0x01, 0x20, 0x00 //
WR_REG THS8200, 0x01, 0x21, 0x00 //
WR_REG THS8200, 0x01, 0x22, 0x00 //
WR_REG THS8200, 0x01, 0x23, 0x23 //
WR_REG, THS8200, 0x01, 0x24, 0x2A //
/1 horizontal timng setup
WR_REG THS8200, 0x01, 0x25, 0x28 //
WR_REG THS8200, 0x01, 0x26, OX6E //
WR_REG THS8200, 0x01, 0x27, 0x28 //
WR_REG THS8200, 0x01, 0x28, 0x04 //
WR_REG, THS8200, 0x01, 0x29, 0x00 //
WR_REG THS8200, 0x01, Ox2A, 0x04 //
WR_REG THS8200, 0x01, 0x2B, OxC0 //
WR_REG THS8200, 0x01, 0x2C, 0x00 //
WR_REG THS8200, 0x01, 0x2D, 0x00 //
WR_REG THS8200, 0x01, Ox2E, 0x00 //
WR_REG, THS8200, 0x01, Ox2F, OXx6E //
WR_REG THS8200, 0x01, 0x30, 0x00 //
WR_REG THS8200, 0x01, 0x31, 0x00 //
WR_REG THS8200, 0x01, 0x32, 0x00 //
WR_REG THS8200, 0x01, 0x33, 0x00 //
WR_REG THS8200, 0x01, 0x34, 0x06 //
WR_REG, THS8200, 0x01, 0x35, 0x72 //
WR_REG THS8200, 0x01, 0x36, 0x80 //
WR_REG THS8200, 0x01, 0x37, 0x02 //
WR_REG THS8200, 0x01, 0x38, 0x82 //
WR_REG THS8200, 0x01, 0x39, 0x27 //
WR_REG THS8200, 0x01, Ox3A, OXEE //
WR_REG, THS8200, 0x01, 0x3B, OxFF //
/1 CSM setup not required if ful
WR_REG THS8200, 0x01, Ox4F, 0x00 //
//di screte output sync contro
WR_REG THS8200, 0x01, 0x70, 0x18 //
WR_REG, THS8200, 0x01, 0x71, 0x06 //
WR_REG, THS8200, 0x01, 0x72, 0x49 //
WR_REG THS8200, 0x01, 0x73, Ox1A //
WR_REG THS8200, 0x01, 0x74, 0x00 //
WR_REG THS8200, 0x01, 0x75, 0x01 //
WR_REG THS8200, 0x01, 0x76, 0x00 //
WR_REG THS8200, 0x01, 0x77, OXC7 //
WR_REG, THS8200, 0x01, 0x78, 0x07 //
/1 discrete input sync control -

dtg_y_syncl
dtg_y_sync2
dtg_y_sync3
dtg_cbcr_syncl
dtg_cbcr_sync2
dtg_cbcr_sync3
dtg_y_sync_upper

dt g_cbcr_sync_upper

dtg_spec_a
dtg_spec_b
dtg_spec_c
dtg_spec_d
dtg_spec_d1l
dtg_spec_e
dtg_spec_h_nsb

dt g_spec_h_Isb
dtg_spec_i _nsb
dtg_spec_i _Isb
dtg_spec_k_Isb
dtg_spec_k_nsb
dtg_spec_k1

dt g_speg_g_|I sb
dtg_speg_g _nsb

dt g_t ot al _pi xel _msb
dtg_total _pixel _Isb
dtg_linecnt_msb
dtg_linecnt_|sb
dtg_node - 720p
dtg frane_field_nsb
dtg_franme_size_l sb
dtg_field_size_lsb
-scal e range is used
csm node di sabl ed

dtg_hlength_I sb
dtg_hdly_nsb
dtg_hdly_Isb
dtg_vlength_Isb
dtg_vdly_nsb

dtg vdly Isb
dtg_vlength2_Isb
dtg_vdly2_nsb
dtg_vdly2_|sb

use to align picture
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4.4.2

WR_REG THS8200, 0x01, 0x79, 0x00 // dtg_hs_in_dly_nsb

WR_REG, THS8200, 0x01, Ox7A, OXOF // dtg_hs_in_dly_Isb - adjust horizontal position
WR_REG, THS8200, 0x01, 0x7B, 0x00 // dtg_vs_in_dly_nsb

WR_REG, THS8200, 0x01, 0x7C, 0x01 // dtg_vs_in_dly_Isb - adjust vertical position
WR_REG, THS8200, 0x01, 0x82, 0x1B // pol _cntl, external FID

END_DATASET
N NN NN NNy

Each command file may contain individual write-to-register (WR_REG) commands.
1. The comment indicator is the double-slash //.

2. The command file is not case-sensitive and ignores all white-space characters.
3. All numbers can be entered as hexadecimal (beginning with 0x) or as decimal.
4

. Every dataset in a command file begins with BEGIN_DATASET and ends with END_DATASET. The
maximum number of datasets is 250.

5. The dataset text description is entered between double quotes using the DATASET NAME command.
The enclosed text can be up to 128 characters in length. This text appears in the System Initialization
dialog box when the command file is opened.

6. The INCLUDE command inserts the contents of an include file (with an .INC file extension) in-line in

place of the INCLUDE command. Therefore, the include file must not contain the BEGIN_DATASET,
END_DATASET, and DATASET_NAME commands.

Note: Allincluded files must be located in the same directory as the command (CMD) file.

7. The write-to-register command is written as follows:
WR_REG, <DeviceFamily>, <Number of data bytes (N)>, <subaddress>, <Datal>,..., <DataN>
or
WR_REG, <Literal slave address>, <Number of data bytes (N)>, <subaddress>, <Datal>,..., <DataN>
The valid device family mnemonics are:
VID_DEC for the video decoders
VID_ENC for the video encoders
THS8200 for the THS8200 device

WinVCC4 translates the device family mnemonic to the slave address that was selected in the
WinVCC4 Configuration dialog box upon program startup. This eliminates having to edit command files
if the alternate slave address must be used.

If the literal slave address method is used, then the slave address entered is used directly. This
method is normally used for programming the video encoder.

8. A delay may be inserted between commands using the WAIT command, which is written as follows:
WAIT,<# milliseconds>

Register Editing

The following sections describe the available modes of register editing: Register Map Editor, Encoder
Module Editor, Generic I°C Register Editor, and Property Sheets. Each of these functions can be selected
from the Edit menu.

4.4.2.1 Register Map Editor

The register map editor (see Eigure 4-§ and Eigure 4-7) allows the display and editing of the entire used
register space of the device within a simple scrolling text box. To open this window, click on Edit Register
Map in the Edit menu, and click on the device type to edit. If the intended device type is not shown, then
use the Windows menu to activate the existing window.
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Main Menu

TVP7002 (0xB8) Register Map

Address | Data I R I Name I Mask | Default I o
0o 02 R CHIP REVISION OxFF —
)| 67 RAv  H-PLL FEEDBACK DIVIDER MSB OxFF 0x67
02 20 RAw  H-PLL FEEDBACK DIVIDER LSB 0xF0 0x20
03 Al RAv  H-PLL CONTROL 0xF8 0xA8
04 80 RAw  H-PLL PHASE SELECT 0xF3 0x80
05 32 RAw  CLAMP START OxFF 0x32
06 20 RMA  CLAMPWIDTH OxFF 0x20
07 60 RAv  HSOUT OUTPUT WIDTH OxFF 0x20
08 3C RAv  BLU FINE GAIN OxFF 0x00 N
NOTE 1: Any address not shown in the list can be accessed by typing the address and then clicking Read or Write.
Loop Count Loop Count ;
Address [ 1 Aeplestowiie Fladi
W -1 Read and Read All. Dec O
_'] [1 = 999] Hex (¢
Data Histogram on Loop Count Reads [or Read Alls)
AND
[0 Readdll | [ Enable oo | FF _Show | Close |

Figure 4-6. TVP7002 Register Map

THS8200 (0x40) Register Map

Addressl Data I R I Name I Mask | Default I ~
02 04 R version 0=FF m
03 0 RM  chip_ctl 0xFF 0x00
04 0o RAY  csc_nicl 0=FF 0x00
05 0o RAY  csc_ifel 0xFF 0x00
06 0o RA  csc_ric2 0xFF 0x00
07 0o RAY  csc_ife2 0=FF 0x00
08 0o RAY  csc_ric3 0=FF 0x00
09 0o RAY  csc_ife3 0=FF 0x00
04 00 RMW csc_aicl 0xFF 000 ™
NOTE 1: Any address not shown in the list can be accessed by typing the address and then clicking Read or Write.
Loop Count Loop Count -
Address Wiite |17 Applies to Write, Had:i
|_| — —l— Read and Read Al Dec
=l (1-999) Hex &
- Read | Histogram on Loop Count Reads [or Read Alls)
AND

Figure 4-7. THS8200 Register Map
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Table 4-2. Register Map Editor Controls

Control

Definition

Register Window

Scrolling text box that displays the address and data for the I°C registers that are defined for the device.

Address Field

This contains the 1°C subaddress that is accessed using the Write and Read buttons. Clicking on a row
selects an address, which then appears in the address field.

Note: After clicking on a row, the Data field contains the data that was in the register window. The device
has not yet been read.

The address up/down arrows are used to jump to the next/previous subaddress that is defined for the
device. If an address is not defined for the device, then it can still be accessed by typing the subaddress
in the Address field.

Data Field

This contains the data that is written to or was read from the 1°C subaddress.
The data up/down arrows increment/decrement the data value by 1.

Write Button

Writes the byte in the Data field to the address in the Address field.

The I2C register is written to whether or not the data is different from the last time the register was read.

Read Button

Reads the data from the address in the Address field into the Data field and the register window.

Read All Button

Reads all defined readable registers from the device and updates the register window.

Hex Button

Converts all values in the register window and address and data fields to hexadecimal.

Dec Button

Converts all values in the register window and address and data fields to decimal.

Close Button

Closes the dialog.
Note: Multiple edit register map windows can be open at the same time (one for each device). Use the
Window menu to navigate.

Loop Count

Causes subsequent write or read operations to be performed N times. N is entered as a decimal number
from 1 to 999.

Edit Indirect Registers

Opens the indirect register editor of the TVP7002.

4.4.2.2 Generic I°C Register Editor

The Generic I°C Register Editor (see allows the display and editing of any device on the I1°C
bus. This editor works like the Register Map Editor, except that the 1°C slave address must be entered and
the Read All button is disabled.

To open this window, click on Edit Register Map in the Edit menu and then click on Generic I°C.

Generic 12C Register Map

Addressl Data l R W ] Name I Description ] A
0o - RAw
m - RAw
02 RAw
03 RAw
04 RAw
05 RAw
06 RAw
07 R
08 R v
12C Slave
Address

,_l [ Use Repeated Start

Loop Count .
Address Wiite 1 Applies to Write iy
l_' 2 I and Read buttons. Dec
= (1-939) Hex (&
Read I Histogram on Loop Count Reads

Data AND

I—_ﬂ | [~ Enable Mask FF ShOW‘ Close |

Figure 4-8. Generic I1°C Register Editor
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45 TVP7002 Property Sheets
The property sheets represent the register data in a user-friendly format. The data is organized by
function, with each function having its own page and being selectable via tabs at the top.
To open a property sheet, click Edit Property Sheets in the Edit menu and select the device type to edit.
When the property sheet function is started or when tabbing to a different page, all readable registers in
the device are read from hardware to initialize the dialog pages. Values on the page are changed by
manipulating the various dialog controls.
There are OK, Cancel, and Apply buttons at the bottom of each property page.
With the TVP7002, there are six different tabs available within its property sheets. The tabs are organized
by the TVP7002 functions. The following sections describe the additional details and recommendations of
the controls within each tab.
4.5.1 Input Mux

The Input Mux Property Sheet provides controls for configuring the input connections and sync options.
For most applications, auto detect is recommended for HSYNC/VSYNC selection and HSYNC input
polarity. The TVP7002 automatically senses the presence of SOG and discrete HSYNC/VSYNC inputs. If
SOG and discrete syncs are both present, then the TVP7002 automatically selects and uses the discrete
syncs. Input sync status is available in the sync detect status I1°C register (14h) and can be viewed using
the status property sheet. The BNC connectors on the TVP7002 EVM inputs must be used for
sync-on-green (SOG) or sync-on-y operation.

TVP7002 (0xB8) Property Sheets

Input Mux I Clamp Conltoll H-PLLI Gain and Uflsetl Uulputl Statusl

Input Selection

HSYNC Selection HSYNC Input Polarity VSYNC Selection
" HSYNC " Active Low " VYSYNC
" S0G " Active High " Sync Sep
(* Auto Detect (* Auto Detect *+ Auto Detect

SOG Low Pass Filter

SOG Threshold & 25MH Sync Separator Threshold
- QL z -
1 64
Z‘ " 10 MHz ZI
[0-31) (0-255)
" 33MHz

" Bypass LPF

Read All

OK Cancel Apply

Figure 4-9. Input Mux Property Sheet
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The SOG threshold (IC register 10h[7:3]) sets the voltage level threshold of the SOG comparator/slicer.
Each step represents an 11-mV change in slice level. The default setting of 0Bh can be used for most
applications.

The Sync Separator Threshold setting defines the sync separator count interval in internal REFCLK cycles
and is used for VSYNC high/low detection and generation. A setting of 64 (40h) should be suitable for all
nominal input formats.

A programmable SOG low-pass filter (12C register 1Ah[7:6]) is provided to filter glitches or noise that could
be present on the SOG input. Recommended settings are shown in [[able 4-3.

Table 4-3. Recommended SOG LPF Settings

SDTV Formats
HDTV and PC Graphics

10 MHz
33 MHz or Bypass

Note: Excessive filtering of high frequency SOG inputs can result in sync tip attenuation and sync
processing issues.
Note: SOG filter settings affect SOG analog delay resulting in a slight HSOUT alignment shift.
When discrete output syncs are used, the HSOUT start setting on the Output Property Sheet
can be used to compensate for this horizontal alignment shift.
45.2 Clamp

Most ac-coupled video applications use the internally generated clamp pulse for dc restoration prior to the
ADCs. The fine clamp start (I2C register 05h) is relative to HSYNC trailing or leading edge depending on
the Clamp REF bit setting in I°C register 15h. In most cases, the trailing edge of the negative sync tip is
used to avoid clamping during the sync pulse.

The fine clamps must be enabled in I°C Register 2Ah and correctly positioned during the horizontal
blanking interval. See for recommended clamp placement settings for various input formats.
HDTV formats having tri-level syncs require additional delay to avoid clamping during the tri-level sync

interval.
LI

____Internal
L1 Clamp
I_ 7 ¥

I
\
[
[
\
o

Bi-Level Sync

Tri-level Sync

A 4

Fine Clamp Start (Register 05h) ——
Clamp Start + Clamp Width (Register 06h) ———
ALC Placement (Register 05h)
ALC Horizontal Filter (Register 05h)
1 to 1/128 (1/N, where N = number of pixels averaged)
Typical Settings  Clamp Start Clamp Width  ALC Placement
HDTV (tri-level) 50 (32h) 32 (20h) 90 (5Ah)
SDTV (bi-level) 6 (06h) 16 (10h) 24 (18h)
PC graphics 6 (06h) 16 (10h) 24 (18h)

Figure 4-10. Clamp and ALC Placement
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Both clamp and auto-level control (ALC) placement are relative on the HSYNC reference edge selected by
the clamp REF bit in I°C register 15h. Most applications set up the TVP7002 to use the trailing edge of the
negative sync tip for placement of the fine clamp and ALC. The maximum ALC horizontal filter setting may
be limited by the back porch duration for some formats.

Either bottom-level or middle-level clamping can be selected. These must be set according to the video
input format. Bottom-level clamping must be used for Y and RGB inputs. Middle-level clamping must be

used for Pb and Pr inputs. Coarse clamp must be left disabled for most applications. A typical clamp setup

for RGB graphics is shown in [Table 4-4 and Figure 4-17].

Most applications use the internal fine clamp pulse that is automatically generated from the HSYNC input.
Clamp polarity is only effective when an external clamp is used.

Note: The maximum ALC horizontal filter setting that can be used with some formats may be
limited by the back porch duration.

Table 4-4. Typical Clamp Setup for RGB Graphics

I°’C Address Setting Description
05h 06h Clamp start
06h 10h Clamp width
OFh OEh Internal clamp enabled
10h 80h Bottom-level clamping for RGB
15h 00h Clamp pulse relative to HSYN trailing edge
2Ah 87h Enable fine clamps
2Dh 00h Coarse clamp disabled

SLEU098—-May 2008
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TVP7002 (OxB8) Property Sheets

Input Mux  Clamp Cantrol I H-PLL | Gain and Offset | Output | Status |
Course Clamp Enables Clamping Level Clamp Low Pass Filter
R/Pr Bottom - 0.5 MHz
" 1.7 MHz
¥ Fine Clamp Enabl G/Y  Bottom
ine Clamp Enable 4.8 MHz
B/Pb Bottom * Reserved
Clamp Source Clamp Polarity Clamp Pulse Placement wrt Clamp Start
Intemal I (* Active High (¢ HSYNC Trailing Edge g ZI
(L Activa llow (" HSYNC Leading Edge (0 - 255 pixels)
Clamp Width
16 i‘
(0 - 255 pixels)
Read all
OK Cancel Apply

Figure 4-11. Clamp Control Property Sheet

Note:
for PbPr inputs.

Bottom-level clamping is required for YGBR inputs, while middle-level clamping is required

A programmable coarse clamp low-pass filter is provided (see 1°C register 1Ah) primarily for use with the
SOG inputs that utilize a coarse bottom level sync tip clamp only. Recommended filter settings are shown

in [Table 4-3.
Table 4-5. Recommended Clamp LPF Settings
SDTV Formats 0.5 MHz
HDTV and PC Graphics 4.8 MHz
Note: Excessive clamp filtering can lead to SOG clamp level and sync processing issues.

453 PLL

A PLL setup calculator is integrated into the H-PLL Property Sheet. The H-PLL Feedback Divider, VCO
range, and Charge Pump settings can be automatically calculated by entering the HSYNC and Pixel
frequencies and pressing the Calculate>> button. The new settings are not written to the TVP7002 until

the Program>> button is pressed.
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Typically the Preferred Post Divider will be set to 1, and the feedback divider will be set to the total
number of pixels per line. For lower frequency SDTV video formats, a 2x feedback divider value can be
used with a Post Divider of 2 to improve jitter performance. In this case, the PLL operates at twice the
desired frequency, but the output pixel rate will be at the PLL frequency divided by 2.

Note: When a Post Divider of 2 is used, only 16 of the 32 ADC clock phase control settings are
available for use in the H-PLL Phase Select Register. ADC clock phase adjustments are
typically required for PC graphics for precise alignment of the sample clock with the input
pixel.

TVP7002 (0xB8) Property Sheets

Input Mux] Clamp Control H-PLL I Gain and Dflsetl Uutputl Statusl
Current Status Frequency Entry Preferred Calculated Settings Current Register Settings
F Post Divider o .
rame Rate 1 Feedback Divider Feedback Divider
(Hz) — (0 - 4035) (0 - 4035)
Horiz Freq = Post Divider Post Divider
45,000 > 45 KHz 1 S
[KHz) (1.0-255.0)
Calculate >> Program >>
Pixel Freq Pixel Freq 4, VCD Range 4’ VCO Range
74.250 > 74.25 MHz Medium Medium v
(MHz) (1.0-165.0)
Charge Pump Current Charge Pump Current
4 4 v
ADC Clock Phase Control Coast Polarity Coast Timing [HSYNCs)
0 180 360 Sweep Coast Source " Active Low Pre-Coast  Post-Coast
' | ; " Active High 1= 0=
l 180.00 (deg) & ZJ Z’
| Auto Detect (0-255) (0-255)
NOTES:
1. Click ">>" button to use measured HSYNC Freq (or type HSYNC Freq).
2. Type Pixel Freq [or click ">>" to use current status). d
3. Click Calculate to generate HPLL settings. A Pl
4. Click Program to program the HPLL registers. Read All Enabled
OK Cancel Apply

Figure 4-12. PLL Property Sheet

The Frame Rate, Horiz Freq, and Pixel Freq information reported in the Current Status frame are
calculated values based on the current H-PLL Feedback Divider and the Lines/Frame and Clocks/Line
Status read from the TVP7002 registers. The precision of these calculated values will depend on whether
the internal reference clock or the 27-MHz external reference clock is selected. Current settings and status
can be read at any time by pressing the Read All button.

An internally or externally generated coast signal can be used to put the PLL in coast or free-run mode to
avoid disruptions in HSYNC during vertical blanking. When the internal coast is in use, the pre-coast and
post-coast settings specify the coast interval range relative to the internally-detected VSYNC. Pre-coast
specifies the number of lines before detecting VSYNC, and post-coast specifies the number of lines after
VSYNC that are used for the coast interval.
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Table 4-6. Recommended Coast Settings

Format Pre-Coast Post-Coast
480i/p 03h 03h
576i/p 03h 03h
1080i 01lh 00h
1080p 01lh 00h
720p 01lh 00h
PC graphics with SOG 01lh 00h

45.4 Gain and Offset - ALC

The Gain and Offset property sheet provides controls for both analog and digital gain/offset adjustment.
The coarse gain and offset are analog in hature and are applied prior to the ADCs. Fine gain, fine offset,
and automatic level correction (ALC) are applied in the digital domain after the ADCs. Coarse gain
provides an analog gain range of 0.5 to 2.0, while Fine gain provides a digital gain range of 1 to 2.

B TVP7002 (0xBB) Property Sheets H=1E3
Input Mux | Clamp Control | H-PLL ~ Gain and Offset I Output | Status |
Coarse [Analog) Gain Fine [Digital) Gain Automatic Level Control [ALC)
t Defaul
L 2 L . e e o Enabled
R [ —7 | -
| R | 0
| ALC Placement
N — 6 | 0 30 2
B l 7 B | 0 =
l ] | (0 - 255)
Coarse [Analog) Offset Fine (Digital) Offset ALC Fiter Coefficients
Horizontal
3 0 31 Default { Default
l 512 Ul 511 178 =
§ J 16 R i 0
— Vertical
[ 16 [
G | G A 0 171024~
B _]l 16 B J[ 0
[~ Lock red and blue sliders to green slider Read Al

OK Cancel Apply

Figure 4-13. Gain and Offset Property Sheet

Stable output offset levels are maintained by use of the ALC feedback level control in the TVP7002. Two
sets of filter coefficients are available that define the level of filtering applied on each line (horizontal) and
the amount of feedback correction that is applied per line update (vertical). The horizontal coefficient (1°C
register 28h, NSH[2:0]) specifies the number of pixels that are used in the horizontal filter. The ALC filter
must be applied during the horizontal blank interval following the clamp pulse, so it must be correctly
positioned using the ALC placement register (register 31h). The amount of horizontal filtering that can
used depends on the ALC placement and the horizontal blanking interval of the input video format. See
for recommended ALC placement settings.

30
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The vertical coefficient (I2C register 28h, NSV[3:0]) specifies the amount of feedback error correction
derived from the horizontal filter that is applied to each line update. The NSV coefficient can range from 1
(maximum error applied) to 1/1024 (minimum error applied). The TVP7002 default filter coefficients should
be adequate for most applications.

In the ALC operating mode, the fine offset registers are used to position the final digital output levels. To
prevent bottom-level clipping at the ADCs, a coarse offset setting of 16 (10h) is recommended. Any
clipping that occurs at the ADC input cannot be recovered by the ALC.

Table 4-7. Recommended ALC Settings

Format Register 31h ALC Placement Register 28h ALC Filter
SDTV and PC graphics 24 (18h) 53h
HDTV 90 (5Ah) 53h

4.5.5 Output

The Output property sheet provides controls for enabling outputs, selecting the output format, setting
HSOUT polarity/position/width, and specifying embedded sync or Data Enable (DE) output timing. At
power-up, the RGB data, DATACLK, and syncs are in a high-impedance state until enabled in 1°C register
17h or until programming the TVP7002EVM with one of the datasets include in the initialization file. The
DATACLK output polarity is selectable in I°C register 18h.

TVP7002 (0xB8) Property Sheets

Input Mux | Clamp Control | H-PLL | Gain and Offset  Output I Status |
Enables Output Format Output Order HSOUT Polarity
[~ Power Down g " Cr,Cb Active High
v RGE, DATACLK, HSOUT, VSOUT, FIDOUT 422 ¢ Cb.Cr
vV SOG Dutput ’ WSOUT Polarity
I” Color-Space Conversion Active Low
I” Embedded Sync Insertion
Output Code Range Clock Out Digital Data
|RGB coding range (Y. Cb, Cr: 0 to 1023) v| | |OnDATACLK faling edge |
HSOUT Start AVID Start VBLK Offset (FO)  VBLK Length (FO)  F-Bit Start (FO)
| 53i“ 327i|| sﬂ | BUiH Ui‘
(0 - 255 pixels) (0- 8191 pixels) (0 - 255 lines) (0 - 255 lines) (128 to 127 lines)
HSOUT Width AVID Stop VBLK Offset (F1)  VBLK Length (F1)  F-Bit Start (F1)
0w | 1611 2] | 64 | 02 | 04
(0 - 255 pixels) [0- 8191 pixels) [0 - 255 lines) (0 - 255 lines) [-128 to 127 lines)
Read All
OK Cancel Apply

Figure 4-14. Output Property Sheet

The TVP7002 provides support for a 30-bit 4:4:4 or a 20-bit 4:2:2 output format. The 20-bit 4:2:2 output
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4.5.6

format must be used when either the color space converter or embedded digital syncs are used.
Additionally, when embedded syncs are used, the ITU-R BT.601 or the extended (4-1019) output code
range must be used instead of the full (0 to 1023) RGB output code range. When the ITU-R BT.601
reduced code range (YRGB range = 64-940) is used, the YRGB fine digital offset settings should be set to
64 to avoid clipping of active video below code 64.

The AVID Start/Stop, VBLNK Offset/Length, and F-Bit Start settings define the position of the embedded
sync code transitions and also the position of the Field ID (FID) and Data Enable (DE) when these outputs
are used. When embedded syncs are enabled, the SAV embedded sync position can be adjusted with the
AVID Start setting, and the EAV code can be adjusted with the AVID Stop setting. The lines where the
embedded V-bit and F-bit transitions occur can be adjusted with the VBLK and F-Bit settings. See

for more information on embedded sync settings.

The TVP7002 color space converter (CSC) can be used to convert an RGB input to 20-bit YCbCr. The
TVP7002 should default to CSC coefficients required for conversion of RGB to HDTV YCbCr. The CSC
coefficients are fully programmable in 1°C registers 4Ah to 5Bh. See for coefficients required
for conversion to both HDTV and SDTV YCbCr color spaces.

Note: FID and DE output support is provided through use of the multi-function FIDOUT pin 22. See
I2C register 17h for more information.

Status

The Status property sheet reports input sync status from 12C register 14h and line and frame rate
information available in I°C registers 37h to 39h. Lines per Frame and REFCLKs per Line are read directly
from the 1°C registers, while the calculated status is derived from the measured values and the current
H-PLL feedback divider.
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TVP7002 (OxB8) Property Sheets

Input Mus | Clamp Control | H-PLL | Gain and Offset | Output  Status |

HSYNC Input Status YSYNC Input Status Measured Values Calculated Status
| NOT DETECTED | NOT DETECTED ,7'3'”‘3'3 el Lines per Frame Frame Rate
ACTIVE HIGH ACTIVE HIGH o _ _ e
I | [Current H-PLL Setting) (Hz)
| FROM SOG | FROM SYNC SEP REFCLK Freg REFCLKs per Line Horiz Freq
[ 27000 &0 [ 45000
SOG Input Status COAST Input Status (MHz) (KHz)
| DETECTED | ACTIVE HIGH ¥ Extemsl REFCLK | HSYNC Width Pisel Freq
| 14 | 74250
(REFCLKs) (MHz)
VSYNC Width
5
Lines
Chip Revision ( ) Auto-Update

Mo ReadAl | O Enabled

OK | Cancel

Figure 4-15. Status Property Sheet

Either an internal REFCLK (~6.5 MHz) or an external 27-MHz REFCLK can be used for REFCLKS per
Line and HSYNC Width detection. The external 27-MHz REFCLK is recommended for a more stable and
precise read back. The TVP7002 EVM is shipped with a 27-MHz oscillator connected to the EXTCLK input
(pin 80).

Note: The internal REFCLK is not a precise clock source. Some part to part variation in clock
frequency and status read back should be expected.

45.6.1 Reading the Register Map
The property sheets were designed so that the data displayed is always current. Certain actions cause the
entire register map to be read from the device and to update the property sheets. This happens when:

Property sheets are initially opened.

Tabbing from one page to another.

Read All is clicked.

Making the Property Sheets window the active window (by clicking on it).

Making a Register Map Editor window the active window (by clicking on it).

arwNRE
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45.6.2 Auto-Update from Device

Items 4 and 5 above are referred to as the Auto-Update feature. Auto-Update can be disabled by setting
its program option button to DISABLED. This button is located on the initial dialog box (WinVCC4
Configuration).

With Auto-Update enabled (default), the user can open both the Property Sheets and the Register Map
Editor at the same time. Changes made to the Property Sheets (and applied) are updated in the register
map window as soon as the Register Map window is clicked on. It also works the other way; changes
made in the Register Map Editor are updated in the Property Sheets as soon as the Property Sheets
window is clicked on.

Table 4-8. Use of Property Sheet Controls

Property Sheet Dialog Control What Do | Do With I1t? When is Hardware Updated?

Read-only field Read status information N/A

Check box Toggle a single bit After Apply

Drop-down list Select from a text list After Apply

Edit box Type a number After Apply

. . Up/down arrows: Immediately

Edit box with up/down arrows Use up/down arrows or type a humber Type a number: After Apply

Slider Slide a lever Immediately

Pushbutton Initiate an action Immediately

Table 4-9. Property Sheet Button Controls
Button -
Control Definition

OK Writes to all writeable registers whose data has changed. A register is flagged as changed if the value to be
written is different from the value last read from that address.
Closes the dialog.

Cancel Causes all changes made to the property page since the last Apply to be discarded. Changes made to dialog
controls with 'immediate hardware update' are not discarded, because they have already been changed in
hardware.

Does not write to hardware.
Closes the dialog.

Apply Writes to all writeable registers whose data has changed. A register is flagged as changed if the value to be
written is different from the value last read from that address.
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This chapter describes ways to troubleshoot the TVP7002EVM.

5.1 Troubleshooting Guide

Chapter 5

SLEU098—-May 2008

Troubleshooting

If there are problems with the TVP7002EVM hardware or the WinVCC4 software, see and

for possible solutions.

Table 5-1. TVP7002EVM Troubleshooting

Symptom

Cause

Solution

At startup, the error message "Cannot
find DLL file DLPORTIO.DLL"
appears.

The parallel port driver supplied with
the EVM has not been installed.

Run Port95NT.EXE on the CD to install the driver.

Blank screen

Wrong analog input is selected.

Go to Edit->Property Sheets->TVP7002, Analog
Video page, select the correct video input(s) and
click Apply.

The Composite Video 1 input is default.

Source is connected to the wrong
input connector.

Connect source to the correct input connector.

Vertical stability or flashing display

Mode detect issue due to
HSYNC/VSYNC alignment

Adjust HSYNC output delay

Line noise present with
high-frequency vertical line input
pattern

PLL phase setting is not set correctly
for the input source

Adjust PLL phase setting

Line noise present with flat field

Excessive noise on the input source

Filter the inputs or try a different source

Picture too dark

Clamp or ALC not set correctly

Reposition Clamp or ALC. Reduce ALC horizontal
filter coefficient

SOG!/Y does not work

SOG clamp disabled

Set SOG_CE bit in register 2Eh to 1.

SOG does not work when using the
VGA connector

The VGA input is not connected to an
SOG input pin

The BNC connectors must be used for SOG
operation
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Table 5-2. I°C Troubleshooting

Symptom

Cause

Solution

No 12C communication

1°C slave address is wrong.

Close and restart WinVCC4. Choose the alternate slave
address in the WinVCC4 Configuration dialog.

Parallel cable is not connected from PC

parallel port to the EVM DB25 connector.

Connect cable.

EVM is not powered on.

The power supply must be plugged into a 100-V to 240-V/
47-Hz to 63-Hz power source and the cord must be plugged
into the power connector on the EVM.

Wrong type of parallel cable

Some parallel cables are not wired straight through
pin-for-pin. Use the cable supplied with the EVM.

PC parallel port mode is not set correctly.

Reboot PC, enter BIOS setup program, set parallel port LPT1
mode (address 378h) to ECP mode or bidirectional mode
(sometimes called PS/2 mode or byte mode). If already set to
one of these two modes, switch to the other setting (see

Eecion 5.2

Device was placed in power-down mode.

Press the reset button on the TVP7002EVM.

EVM was configured for an external 1°C
master.

Reinstall 0-Q resistors R5 and R6. Control EVM using the PC
parallel port.

Still no 1°C communication

The PC may not be capable of operating in the required
parallel port mode. This is true of some laptop computers.
Use a different computer, preferably a desktop PC.

When WinVCC4 is started and the WinVCC4 Configuration dialog box is closed with OK, the I1°C system
test is performed (unless the I2C System Test program options button was disabled).

If the 1°C system test fails, a dialog box appears. reports that a read from TVP7002 failed,
using slave address 0xB8, subaddress 0x05. The data read was 0x00.

After noting which device had a problem, click OK to continue. Next, the Corrective Action Dialog box
appears to help fix the problem.

12C Test Report

THS8200...FAILED - Read, Dev=0x40, Addr=0205, D ata=0x00 - Miscompare [Wrote 0x01)

TVP7002...FAILED - Read, Dev=0xBA, Addr=0x04, Data=0x00 - Miscompare [Wrote 0x03)

Figure 5-1. I°C System Failure Dialog Box

36
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5.2 Corrective Action Dialogs
After closing the 1°C system test report dialog box, the dialog box in appears.

'E Is a parallel cable connected from the computer's LPT1 port to the evaluation module (EYM) and power applied to the
.

EVM ?

Figure 5-2. Corrective Action Dialog Box

1. If the parallel port cable is NOT connected between to PC and the TVP7002EVM or if the EVM power
is not on, then:

Click NO.

The dialog box shown in appears with instructions on how to correct the problem.

Correct the problem.

Click OK to continue

cpow

! § Connect a parallel cable from the computer's LPT1 port to the EVM and apply power to the EVM. Then, click OK.

Figure 5-3. Corrective Action Required

2. If the cable is connected from the PC parallel port to the TVP7002EVM and the EVM power is on:

a. Click Yes.
b. The dialog box shown in appears. This dialog box appears if the PC parallel port mode
setting may need to be changed.

Note: Run the PC BIOS setup program only if the I?°C communication problem cannot be
resolved in another way (correct slave address settings, reset or power cycle the EVM,
and/or check that the device type selected was TVP7002).

Click OK to continue.

Click OK to close it and get to the main menu.
Click Exit in the File menu to exit the program.
See troubleshooting guide above.

. This program MAY NOT work with the current parallel port mode setting in BIOS, IF the I2C communication problem

d CANNOT BE RESOLVED IN ANOTHER WAY (Correct device type andjor slave address settings, reset or power cycle
the EVM.), restart this computer and enter the BIOS setup program. Change the LPT1 parallel port { base address:
0x378 ) to ECP mode or to BI-DIRECTIONAL mode (also called PS/2 mode or BYTE mode). If one of these two modes
is already selected, change to the opposite mode.

~oao

The following parallel port modes were found to be functional: ECP:Bidirectional + SPP + BI-DIRECTIONAL.

Figure 5-4. Corrective Action Required
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5.2.1 Setting the PC Parallel Port Mode

Note: Run the PC BIOS setup program only if the I°C communication problem cannot be resolved
in another way (correct slave address settings, reset or power cycle the EVM, and/or check
that the device type selected was TVP7002).

1. Restart the PC.

2. During the boot process, enter the BIOS setup program by pressing the required key (the initial text
screen usually indicates which key to press).

3. Find where the parallel port settings are made.

4. Set the parallel port LPT1 at address 378h to ECP mode or bidirectional mode (sometimes called PS/2
mode or byte mode). If one of these two modes is already selected, then change to the opposite mode.

5. Exit and save changes.

5.2.2 General I°C Error Report

The error report shown in appears when an I>C error occurs at any time other than after the 1°C
system test. In this example, there was an acknowledge error at slave address 0x54 (the video triple ADC
module). The error occurred on Read Cycle Phase 1 on the device (slave) address byte.

12C Error Report

Read, Dev=0zBA, Addr=0x00, Data=0x00 - NO ACKN: RD1-DEV

I Ignore |2C Acknowledge Erors

Exit Program

Figure 5-5. I°C Error Report
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TVP7002 EVM Rev 1.0

VSIA

REV 1.1

Number

$-Tun-2007

TVP7002 EVM

Title

Size
B

Date:
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Recommended PLL Settings

Table A-1. Recommended PLL Settings

Pixel PLL PLLDIV | o b Output VCO cp
Standard | Resolution Frame Line Rate Rate Divider [11:4] [3:0] Re Reg 03h Divider Range Current
Rate (Hz) | (kHz) (MH?) (Total | Reg01h | oo f 4? 9 Reg 04h | Reg 03h | Reg 03h
pix/line) [7:0] : [0] [7:6] [5:3]
ULow
640 x 480 | 59.94 31469 | 25.175 800 32h 00h 20h 0 (00b) 100b
ULow
640x 480 | 72.809 | 37.861 315 832 34h 00h 20h 0 100b
VGA (00b)
640 x 480 75 375 315 840 34h 8oh 20h 0 L(JO"O‘L";’ 100b
640 x 480 | 85.008 | 43.269 36 832 34h 00h 60h 0 Low (01b) | 100b
800 x 600 | 56.25 35.156 36 1024 40h 00h 58h 0 Low (01b) | 011b
800x 600 | 60.317 | 37.879 40 1056 42h 00h 58h 0 Low (01b) | 011b
SVGA | 800x600 | 72.188 | 48.077 50 1040 41h 00h 58h 0 Low (01b) | O1lb
800 x 600 75 46.875 49.5 1056 42h 00h 58h 0 Low (01b) | 011b
800 x 600 | 85.061 | 53.674 56.25 1048 41h 80h 58h 0 Low (01b) | O11b
1024 x 768 | 60.004 | 48.363 65 1344 54h 00h 58h 0 Low (01b) | 011b
wan | 1024x768 | 70069 | 56476 75 1328 53h 00h A8h 0 Med (10b) |  101b
1024x 768 | 75.029 | 60.023 78.75 1312 52h 00h A8h 0 Med (10b) |  101b
1024 x 768 | 84.997 | 68.677 94.5 1376 56h 00h AOh 0 Med (10b) |  100b
1280 x 768 | 59.995 | 47.396 68.25 1440 5Ah 00h 50h 0 Low (01b) | 010b
WXGA () 1280 x 768 | 59.87 47.776 79.5 1664 68h 00h AOh 0 Med (10b) |  100b
1280 x 768 | 74.893 | 60.289 | 102.25 1696 6Ah 00h AOh 0 Med (10b) |  100b
1280 x 768 | 84.837 | 68.633 117.5 1712 6Bh 00h AOh 0 Med (10b) |  100b
112g§4" 60.02 | 63.981 108 1688 69h 80oh AOh 0 Med (10b) |  100b
1280 x .
SXGA 1024 75.025 | 79.976 135 1688 69h 80h Esh 0 High (11b) | 101b
1280 x .
1004 85.024 | 91.146 157.5 1728 6Ch 00h Esh 0 High (11b) | 101b
1400 x
1050 50.948 | 64.744 101 1560 61h 80h AOh 0 Med (10b) |  100b
1400 x
SXGA+ 1050 50.978 | 65317 | 12175 1864 74h 80h 98h 0 Med (10b) | 011b
1400 x _
1080 74.867 | 82.278 156 1896 76h 80h EOh 0 High (11b) | 100b
1440 x 900 | 59.901 | 55.469 88.75 1600 64h 00h AOh 0 Med (10b) |  100b
WXGA (1) 1440 x 900 | 59.887 | 55.935 106.5 1904 77h 00h 98h 0 Med (10b) | 011b
1440 x 900 | 74.984 | 70.635 | 136.75 1936 79h 00h EOh 0 High (11b) | 100b
1440 x 900 | 84.842 80.43 157 1952 7Ah 00h EOh 0 High (11b) | 100b
UXGA 1fggox 60 75 162 2160 87h 00h EOh 0 High (11b) |  100b
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Table A-1. Recommended PLL Settings (continued)
) PLL PLLDIV Output V/elo) cP
Standard | Resolution Frame Line Rate l:;;(g Divider [11:4] [;’IBI]_I;IQ/ Req 03h Divider Range Current
Rate (Hz) | (kHz) (MH?) (Total | Reg01h | o h 4? 9 Reg 04h | Reg 03h | Reg 03h
pix/line) [7:0] : [0] [7:6] [5:3]
. ULow
720 x 480i | 29.97 15.734 13.5 858 35h AOh 18h 0 (00b) 011b
720 x 576 25 15.625 135 864 36h 00h 18h 0 L(JO"O‘L";’ 011b
ULow
720x 480p | 59.94 31.469 27 858 35h AOh 18h 0 (00b) 011b
720 x576p | 50 31.25 27 864 36h 00h 18h 0 L(JOLO%";’ 011b
17228ng 60 45 74.25 1650 67h 20h AOh 0 Med (10b) |  100b
Video
1280 x
720p 50 375 74.25 1980 7Bh coh 98h 0 Med (10b) | 011b
11902800;‘ 60 33.75 74.25 2200 89h 80h 98h 0 Med (10b) | 011b
1920 x
10801 50 28.125 74.25 2640 ASh 00h 90h 0 Med (10b) | 010b
11%2% X 60 67.5 148.5 2200 89h 80h EOh 0 High (11b) |  100b
p
1920 x .
1080p 50 56.25 148.5 2640 A5h 00h Dsh 0 High (11b) | 011b
54 Recommended PLL Settings SLEU098-May 2008
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Embedded Sync Setups

Table B-1. Embedded Sync Setups

I°C Register SA 480i60 480p60 720p60 1080i60 1080p60 XGA60
Output Format 15h 47h 47h 47h 47h 47h 47h
AVID Start LSB 40h 91h 93h 47h 06h 43h 43h
AVID Start MSB 41h 00h 00h 01lh 01h 01h 01lh
AVID Stop LSB 42h 0Bh 0Dh 4Bh 8Ah 8Ah 07h
AVID Stop MSB 43h 00h 0o0h 06h 08h 08h 00h
VBLK FO Offset 44h 01h 05h 06h 02h 06h 02h
VBLK F1 Offset 45h 01h 05h 06h 02h 06h 00h
VBLK FO DUR 46h 26h 2Ah 1Eh 16h 2Dh 26h
VBLK F1 DUR 47h 26h 2Ah 1Eh 17h 2Dh 26h
FO F-bit 48h 02h 0oh 00h 0o0h 00h 00h
F1 F-bit 49h 01h 0oh 00h 0oh 00h 00h

EAV EAV

2
<

1280 Active Pixels

4— 300 ——»

70 220

AVID Start AVID Stop

40
Figure B-1. 720p60 Example, Total Line Length = 1650 Pixels

AVID Start = Delay Factor + tri-level sync width + back-porch = 27 + 300 = 327 (147h)
AVID Stop = AVID Start + Active Pixels +4 = 327 + 1280 +4 = 1611
AVID Stop = 1611 (64Bh)

The horizontal reference point is the leading edge of the negative sync tip. The delay factor is a TVP7002
internal delay factor and can change slightly with SOG LPF settings. If AVID Stop exceeds the total line
length, then subtract the total line length from the AVID Stop sum. An additional four pixels must be added
to the active video interval.
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Color Space Converter Coefficients

BEG N_DATASET //
DATASET_NAME, "CSC RGB to BT. 709 HDTV YChbCr "

WR_REG TVP7000, 0x01, 0x18, 0x11 // CSC Enabl ed
WR_REG TVP7000, 0x01, Ox4A, OXE3
WR_REG, TVP7000, 0x01, Ox4B, 0x16
VWR_REG TVP7000, 0x01, 0x4C, Ox4F
WR_REG, TVP7000, 0x01, 0x4D, 0x02
VWR_REG TVP7000, 0x01, Ox4E, OxCE
WR_REG, TVP7000, 0x01, Ox4F, 0x06
VWR_REG TVP7000, 0x01, 0x50, OXxAB
WR_REG, TVP7000, 0x01, 0x51, 0xF3
WR_REG TVP7000, 0x01, 0x52, 0x00
WR_REG, TVP7000, 0x01, 0x53, 0x10
WR_REG TVP7000, 0x01, 0x54, 0x55
WR_REG TVP7000, 0x01, 0x55, OXFC
WR_REG TVP7000, 0x01, 0x56, 0x78
WR_REG TVP7000, 0x01, 0x57, OxF1
WR_REG TVP7000, 0x01, 0x58, 0x88
WR_REG TVP7000, 0x01, 0x59, OXFE
WR_REG TVP7000, 0x01, Ox5a, 0x00
WR_REG, TVP7000, 0x01, Ox5b, 0x10
END_DATASET
NN NN NNy
RNy

BEG N_DATASET //

DATASET_NAME, "CSC RGB to BT. 601 SDTV YChCr "

WR_REG TVP7000, 0x01, 0x18, 0x11 // CSC Enabl ed
WR_REG TVP7000, 0x01, Ox4A, 0xC9
WR_REG, TVP7000, 0x01, 0x4B, 0x12
WR_REG TVP7000, 0x01, 0x4C, OxA6
WR_REG, TVP7000, 0x01, 0x4D, 0x03
WR_REG TVP7000, 0x01, Ox4E, 0x91
WR_REG, TVP7000, 0x01, Ox4F, 0x09
WR_REG TVP7000, 0x01, 0x50, 0x66
WR_REG TVP7000, 0x01, 0x51, OxF5
WR_REG TVP7000, 0x01, 0x52, 0x00
WR_REG, TVP7000, 0x01, 0x53, 0x10
WR_REG TVP7000, 0x01, 0x54, 0x9A
WR_REG TVP7000, 0x01, 0x55, OxFA
WR_REG TVP7000, 0x01, 0x56, 0x9A
WR_REG, TVP7000, 0x01, 0x57, OxF2
WR_REG TVP7000, 0x01, 0x58, 0x66
WR_REG TVP7000, 0x01, 0x59, OxFD
WR_REG TVP7000, 0x01, Ox5a, 0x00
WR_REG, TVP7000, 0x01, Ox5b, 0x10

END_DATASET
NN NNy
RNy
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Macrovision Support

Macrovision support is provided through use of the MAC_EN bit in I2C register 22h and the Macrovision
Stripper Width setting in I1°C register 34h. The Macrovision Stripper Width setting defines a window that
masks undesired signals outside the HSYNC interval to avoid disturbance of the H-PLL. The stripper
window is derived from REFCLK cycles, so the settings required depend on which REFCLK is used.

Table D-1. Recommended Reg 34h Macrovsion Stripper Width Settings

(MAC_EN = 1)
Video Standard REG 34h (Ilr]gegg)al REFCLK REG ?EF(CEI)_(I(erLTsaédZ)%MhZ
480i and 576i 24h 83h
480p and 576p 12h 43h
720p 07h 12h
1080i 07h 13h
1080p 03h 0%h

Note: Settings less than those recommenced above can result in clamp and ALC placement
issues. The stripper width setting has no effect when MAC_EN is set to 0.
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IMPORTANT NOTICE

Texas Instruments Incorporated and its subsidiaries (TI) reserve the right to make corrections, modifications, enhancements, improvements,
and other changes to its products and services at any time and to discontinue any product or service without notice. Customers should
obtain the latest relevant information before placing orders and should verify that such information is current and complete. All products are
sold subject to TI's terms and conditions of sale supplied at the time of order acknowledgment.

Tl warrants performance of its hardware products to the specifications applicable at the time of sale in accordance with TI's standard
warranty. Testing and other quality control techniques are used to the extent Tl deems necessary to support this warranty. Except where
mandated by government requirements, testing of all parameters of each product is not necessarily performed.

Tl assumes no liability for applications assistance or customer product design. Customers are responsible for their products and
applications using TI components. To minimize the risks associated with customer products and applications, customers should provide
adequate design and operating safeguards.

TI does not warrant or represent that any license, either express or implied, is granted under any TI patent right, copyright, mask work right,
or other Tl intellectual property right relating to any combination, machine, or process in which Tl products or services are used. Information
published by TI regarding third-party products or services does not constitute a license from TI to use such products or services or a
warranty or endorsement thereof. Use of such information may require a license from a third party under the patents or other intellectual
property of the third party, or a license from Tl under the patents or other intellectual property of TI.

Reproduction of Tl information in Tl data books or data sheets is permissible only if reproduction is without alteration and is accompanied
by all associated warranties, conditions, limitations, and notices. Reproduction of this information with alteration is an unfair and deceptive
business practice. Tl is not responsible or liable for such altered documentation. Information of third parties may be subject to additional
restrictions.

Resale of Tl products or services with statements different from or beyond the parameters stated by Tl for that product or service voids all
express and any implied warranties for the associated TI product or service and is an unfair and deceptive business practice. Tl is not
responsible or liable for any such statements.

Tl products are not authorized for use in safety-critical applications (such as life support) where a failure of the Tl product would reasonably
be expected to cause severe personal injury or death, unless officers of the parties have executed an agreement specifically governing
such use. Buyers represent that they have all necessary expertise in the safety and regulatory ramifications of their applications, and
acknowledge and agree that they are solely responsible for all legal, regulatory and safety-related requirements concerning their products
and any use of Tl products in such safety-critical applications, notwithstanding any applications-related information or support that may be
provided by TI. Further, Buyers must fully indemnify Tl and its representatives against any damages arising out of the use of Tl products in
such safety-critical applications.

Tl products are neither designed nor intended for use in military/aerospace applications or environments unless the Tl products are
specifically designated by Tl as military-grade or "enhanced plastic." Only products designated by Tl as military-grade meet military
specifications. Buyers acknowledge and agree that any such use of Tl products which Tl has not designated as military-grade is solely at
the Buyer's risk, and that they are solely responsible for compliance with all legal and regulatory requirements in connection with such use.

Tl products are neither designed nor intended for use in automotive applications or environments unless the specific Tl products are
designated by Tl as compliant with ISO/TS 16949 requirements. Buyers acknowledge and agree that, if they use any non-designated
products in automotive applications, TI will not be responsible for any failure to meet such requirements.
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